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Chapter 2Chapter 9

The Power Is in 
the Trim

Trimming is at the heart of editing. It’s in the refining of clips’ In and 
Out points and where they meet with other clips that a group of clips on a 
sequence becomes a coherent edit. Although there is no right or wrong way 
to trim, from an aesthetic point of view, there are tools and techniques for 
trimming that can allow you to work quickly and efficiently while at the same 
time allowing you to express whatever aesthetic you want. 

In previous chapters we discussed some essential editing techniques. In this 
chapter we’ll go further and talk about more advanced ways to trim clips. 
We’ll show you the mechanics of using Adobe Premiere Pro’s versatile trim 
tools so that you can get the most out of your edit. 
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Basic Trimming 
While reading this chapter, we’re confident that you’ll find multipurpose trim tools, like 
the Ripple Edit, Rolling Edit, Slip, and Slide tools, a key part of your workflow. Be sure to 
also make the Trim Monitor a frequent stop, because it will provide you with the most 
flexibility for making complex trims. All of these tools can be overkill, however, if you just 
need to make a simple trim (such as adjusting a clip’s In or Out point) without affecting 
other clips or sequence length.

Trim in Source Monitor 
Perhaps the easiest way to trim a clip is by using the Source Monitor. By loading a clip 
into the Source Monitor from a sequence, you can easily adjust its In and Out points as 
well as perform other types of edits like a slip. Let’s take a look at how this works. 

With a clip loaded into the Source Monitor from a sequence, you can trim a clip in two 
basic ways: 

■■ Marking new In and Out points. To trim a clip, you can simply update In or Out points 
on a clip by pressing I or O (or using the Mark In and Mark Out buttons at the bottom 
left of the Source Monitor) at a new location in a clip. After you update an In or Out 
point, the clip on the sequence will update. Keep in mind that if there are clips located 
adjacent to the clip you just trimmed, there will be gaps on one or both sides. 

■■ Dragging In and Out points. If you’re more of a drag-and-drop type of person, 
you can also drag to trim a clip. On the mini timeline in the Source Monitor, simply 
place your cursor over an In or Out point (or at the start or end of a clip). The cursor 
changes into a staple-like tool with arrows pointing to the left and right (Figure 9.1). 
This is either the Trim-in or Trim-out tool (depending on what point you’re on), which 
we’ll explore in the next section when trimming on a sequence. Once the tool 
appears, drag left or right to update the In or Out point of the clip. Just like marking 
a new In or Out point, the clip will update on the sequence. 

Basic Trim on a Sequence
If you’ve used other editorial packages, you’re aware that one of the fastest ways to trim 
is directly on a sequence. As you play back a sequence, you’ll often discover points at 
which a cut would benefit from a trim. Here’s how it works in Adobe Premiere Pro. 

1.	 With the Selection tool active (press V on the keyboard), place the pointer over the 
In or Out point of a clip on a sequence. When you do, you’ll notice that the pointer 
changes into the Trim-in or Trim-out tool with directional arrows (Figure 9.2). Depend-
ing on which way the “staple” opens, you’ll be trimming the Out point (open to the 
left) or In point (open to the right) of a clip. 

2. 	 Drag to trim the clip’s In or Out point. As you drag, below the clip on the sequence, 
you’ll see a timecode sticky showing you how much you’ve trimmed the clip (for-
ward or backward). Likewise, as you drag, in the Program Monitor you’ll see the In 
or Out point you’ve selected to trim dynamically update. 

Closer To Truth
Some screen shots and  

footage for this chapter are from  
the PBS series Closer To Truth;  
Cosmos, Consciousness, God. 
© The Kuhn Foundation. Robert 
Lawrence Kuhn: creator, executive 
producer, writer and host. Peter 
Getzels: producer and director.  
Find out more about the series  
by visiting www.closertotruth.com.

Figure 9.1  Positioning the 
pointer over an In or Out point in 
the Source Monitor changes the 
cursor to the Trim tool, which you 
can use to drag In and Out points 
to a new position. 

Figure 9.2  Similar to the 
Source Monitor, when you place 
the pointer over an edit in a 
sequence, the cursor changes to 
the Trim tool. Depending on what 
side of the edit you’re over, you’ll 
trim either the Out point of the 
outgoing clip or In point of the 
incoming clip. 
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You’ll also see in the Program Monitor a source timecode overlay on the clip that is 
useful if you need to trim to a specific timecode. Additionally, in the Program Moni-
tor on the lower-left and right corners you’ll see two timecode displays. The left 
one is like the sticky you see on the sequence, which indicates how much you’ve 
trimmed. The timecode on the right indicates the new duration of the clip (Figure 9.3). 

3. 	 Release the mouse to make the edit. 

Keep in mind that if you’ve made a trim (making a clip shorter) where two clips meet 
(an edit), you’ll be left with a gap. Later in this chapter, in the “Rippling Edits” section, 
we discuss using the Ripple Edit tool to make a trim without leaving a gap. 

Trim with the Current-time Indicator (Extend Edit)
Another type of trimming operation that you’ll use all the time is Extend Edit. By select-
ing the tracks you want to extend and then positioning the current-time indicator, you 
can then extend an edit point to the current-time indicator. 

1.	 With the Selection tool, lasso or click to select the tracks you want to modify.

2.	 Position the current-time indicator at the point you want to extend to.

3.	 Choose Sequence > Extend Previous Edit to Playhead (E) or Sequence > Extend 
Next Edit to Playhead (Shift +E) 

In the “Rolling Edits” section later in this chapter, we’ll take a look at how this feature 
essentially allows you to roll an edit using the keyboard.

Figure 9.3  When you make a 
trim in a sequence, the Program 
Monitor changes to display 
the new In/Out point as well as 
timecode information about the 
resulting edit. 

No Extend in CS5
If you’re using Premiere Pro 

CS5 there are no extend options in 
the Sequence menu. However, you 
can accomplish the same type of 
edit with snapping enabled and by 
using the Rolling Edit tool. That tool 
is discussed later in this chapter.   
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Rippling Edits
As mentioned earlier, you can trim a clip on a sequence by either its In point or its Out 
point. However, this can cause some problems because you can be left with a gap 
between clips on a sequence after the edit. It’s also problematic because you cannot 
make a clip longer by adjusting the clip’s In or Out point. It would collide with other clips 
around it on the sequence. Sure, there are various ways that you could fix these prob-
lems, but they would take multiple steps. 

Enter the Ripple Edit tool (cue fanfare). Its ability to trim a clip while closing gaps or push-
ing everything else down the sequence is a huge time-saver. Just remember that when 
you ripple an edit point in a sequence, you’ll be changing the length of the sequence. 

For example, if you rippled a clip’s Out point to the left on a sequence (making that clip 
shorter), your entire sequence would become shorter. Likewise, if you rippled a clip’s 
Out point to the right (making that clip longer), your entire sequence would become  
longer. Ripple edits are one-sided, meaning that when you ripple a clip, you don’t 
change the corresponding In or Out point of the clip next to the one you’re trimming. 

Most likely you’re familiar with performing ripple edits in other systems. You may find 
Adobe Premiere Pro’s implementation a little different, so let’s take a look at the way a 
ripple edit works. 

Using the Ripple Edit Tool
Like most nonlinear editing systems, Adobe Premiere Pro has a dedicated Ripple Edit 
tool (B). It allows you to ripple edits quickly and efficiently when used correctly. 

1.	 Navigate to the Chapter Files > Chapter_09_Media > [Version Number] and open 
the project Ch09_ripple.prproj. This a short sequence containing a few clips you 
can use to practice ripple edits. 

2.	 Play back the sequence. Notice in this interview that there are a couple of instances 
where the edits don’t seem quite right. You can fix these issues using the Ripple 
Edit tool. 

3.	 Play back the sequence again, this time paying special attention to the first edit 
point. You should notice that the first interview bite (the person being interviewed) 
seems to get cut off while he is still speaking. That is, the edit cuts to the interviewer 
while the person being interviewed is still talking. To fix this, you need to extend the 
Out point of the first clip.

4.	 In the Tools panel locate the Ripple Edit tool (Figure 9.4). You can also press B to 
activate the Ripple Edit tool.

5. 	 Place the Ripple Edit tool over the edit point, and without clicking move the tool 
from side to side going from the first clip to the second clip. 

Notice how the staple shape of the tool changes depending on what side of the edit 
you’re on? With the open side of the staple facing to the left, you’ll be rippling the 
Out point of the first clip; with the open staple facing to the right, you’ll be rippling 
the In point of the second clip (Figure 9.5). 

You Can Only Ripple So Far
When you ripple an edit, 

it’s important to remember (as 
with other edits) that you can only 
lengthen a clip by using the Ripple 
Edit tool to the media’s limits—you 
can’t invent media you don’t have! 
If a clip is still too short, explore the 
speed change options you learned 
in Chapter 7.

Exercises for This Chapter 
Use H.264 Media

The exercises in this chapter use 
media encoded as H.264. Depend-
ing on your system, you may need 
to adjust Adobe Premiere Pro’s 
fractional resolution or render 
sequences to achieve optimal play-
back, although the footage used is 
likely to play on most systems.

Figure 9.4  The Ripple Edit tool 
is in the Tools panel, but you can 
also activate it by pressing its 
keyboard shortcut (B). 
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6.	 In this exercise you want to extend the Out point of the first clip so that the person 
being interviewed can complete his thought. With the Ripple Edit tool positioned to 
ripple the Out point of the first clip, click and drag to the right, and keep holding the 
mouse button for a moment. 

Notice that two things happen in the interface: 

■■ As you drag, the outline of the clip will show you where the new Out point will be 
relative to the sequence. Also, slightly below the clip that you’re rippling, you’ll 
get a timecode sticky showing you how much you’ve trimmed the clip by. 

■■ In the Program Monitor you should now see a two up display (Figure 9.6). The left 
side shows you the first clip (i.e., the edit point you’re rippling), and the right side 
shows you the second clip in the sequence. As you ripple the first clip, notice 
that the left side of the two up display updates, showing you visually what your 
new Out point will be. You also get the benefit of viewing an overlay with source 
timecode of the clips. Because ripple edits are one-sided, the right side (or the 
second clip’s In point) will not change.

Figure 9.5  The positioning of 
the Ripple Edit tool over the edit 
is important. Depending on which 
side the tool is open to, you’ll be 
rippling either the Out point of 
the outgoing clip or the In point 
of the incoming clip.

The Radio Edit
As you start to trim a se-

quence, one of the first things you 
should focus on is that all of the 
audio (interview bites, narration, 
etc.) is cut together well. This is 
often referred to as a radio edit. The 
Ripple Edit tool is a versatile tool 
that helps you do this. Later you 
can go back and refine video with 
ripple and roll edits or even create 
split edits to better match action 
between video clips. 

Figure 9.6  As you ripple a clip, 
the Program Monitor changes to 
display a two up view of the edit 
complete with timecode overlays 
showing you how much you’ve 
rippled the clip and its new 
duration. 

Toggle Between the Selection 
Tool and Ripple Edit Tool

With the Selection tool active, you 
can quickly switch to the Ripple Edit 
tool by holding down the Command 
key (Mac) or Ctrl key (Windows), 
which can speed up your efficiency 
because you don’t have to switch to 
the Ripple Edit tool.
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7.	 Drag to the right until the subject looks like he’s finished his thought. 

We rippled forward +00:03;00 where the subject says “… my death is just the end 
of the….” Let go of the mouse button to perform the edit. Back up the current-time 
indictor and play back the edit point. You’ll now notice that the edit is much cleaner, 
and the subject doesn’t get cut off. 

8.	 Navigate down to the second edit point. Play through the edit a few times. 

The person being interviewed kind of trips up and doesn’t make a complete 
thought at the end of the second clip. In the previous step you rippled an Out 
point forward, but in this case you’ll ripple it backward to cover up the misspoken 
thought. Using the Trim-in tool, you’d leave a gap if you adjusted the Out point of 
the second shot. But by using the Ripple Edit tool, you can fix this problem quickly. 

9. 	 With the Ripple Edit tool still selected, place the tool over the edit point and make 
sure the open side of the staple shape is facing to the left so you can adjust the Out 
point of the second clip. 

10.	 Click and drag to the left until you see the person being interviewed put his arms 
down in the two up display of the Program Monitor. We rippled this Out point back 
by -00:01;03, just to the point where the person being interviewed says “…it’s all 
there and….” Play back that part of the sequence; the edit is much cleaner. 

If you play back the rest of the sequence, you’ll see that there are similar problems 
throughout. Feel free to practice rippling on all of these different edits. Not only will 
you need to ripple Out points (forward and backward), but you’ll also need to ripple In 
points of clips. For the sake of clarity, we alternated if you need to ripple an edit forward 
or ripple an edit backward with the exception of the last two clips, both of which you’ll 
need to ripple Out points back to make clean edits. 

Play Around an Edit

When you’re previewing an edit point, you’ll want to view it numerous times. It’s help-
ful to quickly back up the playhead before the edit and play through a second or two 
after the edit. 

Unfortuantely, Adobe Premiere Pro doesn’t have a default shortcut for this. But you 
can easily remap the command. Here’s how to do it in CS5.5.

1.	 Open the Keyboard Shortcuts window by choosing Premiere Pro > Keyboard 
Shortcuts (Edit > Keyboard Shortcuts).

2.	 In the Keyboard shortcuts dialog do a search for Play Around.

3.	 Create a custom shortcut of your choosing. We like Option+space. 

4.	 Click OK to store your new settings.

When you use the shortcut with the current-time indicator positioned on or near an 
edit point, the playhead will back up a few seconds, play through the original current-
time indicator position, and stop a few seconds after the original current-time indicator 
position. You can customize how far back and how far through the playhead will back 
up by adjusting Preroll and Postroll settings in the General section of Preferences. 

Linked Clips and Rippling
You may have noticed that 

when you ripple a clip, any linked 
portion of that clip is also rippled. 
This is the default behavior (and 
that’s a good thing!) of Adobe Pre-
miere Pro and many other edit sys-
tems (it helps to keep clips in sync). 
Later in this chapter, in the “Making 
Split Edits” and “Maintaining Sync” 
sections, we’ll discuss unlinking so 
you can make asymmetrical edits. 

Watch the Waveforms!
As you start trimming, you 

might find it helpful to look at the 
audio waveforms of the clips you’re 
trimming. The more you look at the 
waveforms, the easier it will be to 
quickly identify words and phrases 
as you trim a clip, which can be very 
helpful while trimming dialogue.

I Can’t Hear My Audio 
While Rippling!

When performing a ripple edit, you 
can’t hear the audio of the clip. This 
can make it difficult to be exact 
when trimming sound bites. To get 
around this problem, we’re fans of 
using In and Out points or the cur-
rent-time indicator on the sequence 
to first “spot” where we want the 
trim (the edit point) to line up. Then, 
with snapping on when we make 
the ripple edit, the new edit point 
will snap to that point. If snapping is 
off, just click the magnet icon in the 
upper-left corner of the Timeline 
panel or press S on the keyboard.
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Rolling Edits
When you made a ripple edit in the previous section, you trimmed either the In or 
Out point of a clip. This didn’t actually affect the In or Out points of the adjacent clip. 
Because a ripple is a one-sided edit, when you ripple, you change the length of a clip 
and the change “ripples” the length of the sequence. 

A roll edit is a two-sided edit, meaning that you affect both points (Out and In) on either 
side of the edit. Roll edits are perfect for when you’re trying to match action between 
two angles or when you need to adjust an edit so that a cut happens at different points 
in time but doesn’t affect the overall duration of a sequence. Roll edits can also be used 
to create split edits (where audio or video have different In and Out points). Let’s look at 
using roll edits in Adobe Premiere Pro. 

Using the Rolling Edit Tool
Using the Rolling Edit tool is an easy way to perform a roll edit directly on a sequence. 
Let’s take a look at how it works.

1.	 Navigate to the Chapter Files > Chapter_09_Media > [Version Number] and open 
the project Ch09_roll.prproj. This a short sequence similar to the one from the pre-
vious exercise. 

2.	 Play back the sequence. Notice that the timing for some of the edits seems a bit off. 

In the first edit, note that the initial shot cuts to the interviewer while the person being 
interviewed is talking. And when it cuts, the interviewer says a few “uhhs” before 
actually asking his question. Let’s roll this edit so you can see the person being inter-
viewed for his entire bite and eliminate the misspoken words of the interviewer. 

3.	 Play through the first edit again, and then position the current-time indicator on 
the second clip right before you hear the interviewer say, “Some people.” This is 
one second forward of where the edit is currently. 

4.	 Make sure that snapping is turned on. Choose Sequence > Snap, or press S to 
toggle snapping on and off. 

5.	 Select the Rolling Edit tool in the Tools panel or press N (Figure 9.7). 

6.	 Click and drag the first edit to the right with the Rolling Edit tool. Because snapping 
is enabled, the edit will automatically snap to the current-time indicator. 

7.	 Back up the current-time indicator and play through the edit.

You should now notice that the person being interviewed is allowed to finish his 
thought onscreen, and you no longer hear the interviewer jumble his words at the 
start of the clip. 

Ripple Each Side or Roll?
When it comes to finessing 

dialogue, many editors prefer to 
work each side of an edit indepen-
dently by rippling each side (shorter 
or longer) to get dialogue working. 
Then they use a roll to finesse ac-
tion between two shots. In this roll 
edit exercise, you could do either. 
But because you’re working with 
linked audio and video, a roll will 
work just fine. Which method you 
choose in your own projects is re-
ally your preference. 

Figure 9.7  You can click the 
Rolling Edit tool in the Tools 
panel, or you can activate it by 
pressing N. 
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Roll an Edit Using the Keyboard
Earlier in this chapter, we discussed using the Extend Edit function. Being able to 
extend a single edit point to the current-time indicator is useful in situations like extend-
ing a shot at the end of an act to a certain timecode so your act meets a broadcaster’s 
requirements (often called a clock). But you can also use this same functionality to 
perform a roll edit using the keyboard. Here’s how it works. 

1.	 With the same project open from the previous exercise, navigate to the edit point 
between the second and third clips. 

2.	 Play through the edit a few times. As in the previous example, this edit could benefit 
from a roll edit because the timing between the clips is not quite right. 

3. 	 Position the current-time indicator to the point in the third clip right before you 
hear the person say, “I met….” Next, select the track headers for the video track 
and both audio tracks so they take place in the edit. Then press Shift+E or choose 
Sequence > Extend Previous/Next Edit to Playhead.

The edit point is rolled to the current-time indicator without having to drag the edit 
point with the Rolling Edit tool (Figure 9.8). 

This sequence contains another edit point that could use a roll to make it smoother. 
Using any of the methods you’ve learned, roll the edit between the fourth and fifth 
clips to smooth the edit. We’ll give you a hint: The edit will work better if you roll back 
to the left. 

Selecting/Deselecting 
Tracks Quickly 

With no tracks selected, you can 
quickly select all tracks (either 
video or audio) by Shift-clicking 
a track: All of the other video or 
audio tracks will be selected. With 
multiple tracks selected, Shift-click 
to deselect them. Of course, you 
can select or deselect an individual 
track at any time by just clicking on 
a particular track. 

Figure 9.8  By positioning 
the current-time indicator to 
the point where you want the 
edit to be and then extending 
the edit to that point, you can 
essentially roll the edit by using 
a keyboard shortcut. 
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Slipping Edits
For some editors, the concept of a slip edit can be a little confusing. Here’s a simple 
example of what slip edits can do for you: You’ve marked a clip (In and Out points) and 
edited it into a sequence, but something is not right. Where it cuts into the action the 
shot feels off, and where it cuts out of the action it feels off too, but the duration or tim-
ing of the clip feels just about right. 

When you perform a slip edit, you don’t change the duration of a clip; rather, you 
simultaneously adjust the In and Out points of a clip so that the action better suits your 
needs. You can make slip edits in a few different ways in Adobe Premiere Pro. Let’s 
work through a few slip edit exercises. 

Slipping an Edit in the Source Monitor
Many editors find making slip edits in the Source Monitor to be the most straightforward 
and the easiest way to visually perform this type of edit. The reason is that you can eas-
ily view your In and Out points and how they relate to one another. 

1.	 Navigate to the Chapter Files > Chapter_09_Media > [Version Number] and open the 
project Ch09_slip.prproj. This a short sequence, which is an interstitial from the PBS 
show Closer To Truth. A few clips are included so you can practice using slip edits.

2.	 Play back the sequence. You can see that the edits flow OK, but on many of the shots 
the action seems to be wrong, showing dead space while the camera is panning or 
adjusting zoom.  

3.	 Look at the first clip in the sequence. 

Notice that the camera is focused on the background (bushes) for far too long 
before panning over to the subject. But the overall timing seems good. Let’s slip this 
clip so you can see less of the background and more of the subject. Double-click on 
this clip to load it into the Source Monitor. 

Note that there are In and Out points on the clip, and the clip is 6:06 in duration. 
Also, a gray bar is visible on the mini timeline in the Source Monitor.

4.	 Place your cursor in the middle of the gray bar (where there are four vertical lines). 
When you do, your cursor will become a hand (Figure 9.9). Click and drag to the right. 

The clip has been replaced in the Source Monitor with a four up view:

■■ The top-left image shows you the clip before the one you’re slipping. In this case 
it’s just black because you’re slipping the first clip in the sequence. 

■■ Below that is the In point of the clip you’re slipping. 

■■ The upper-right image shows you the clip after the clip you’re slipping. 

■■ Below that is the Out point of the clip you’re slipping. 

The In and Out points also have an overlay of source timecode (Figure 9.10). Drag 
until you’ve made 02:16:45:10 the new In point and 02:16:51:15 the new Out point. 

5.	 Release the mouse to make the edit. 

Figure 9.9  With the cursor 
positioned in the mini timeline in 
the Source Monitor, you can click 
and drag (in either direction) to 
quickly slip a clip. 
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After making the edit, notice that the clip duration is exactly the same.

Also, the sequence duration hasn’t changed at all, and the clips surrounding the clip 
you just slipped are unaffected. Play back the first clip to check your work. All of the 
dead space has been removed, and you can now see more of the subject. 

Using the Slip Tool
Although slipping in the Source Monitor is easy to do, the fact is that it requires the 
extra step of double-clicking a clip to load it into the Source Monitor. As an editor, you 
know that even small extra steps can burn valuable time in a project. Therefore, you 
might find it faster to slip a clip within a sequence. 

1.	 With the same project open from the previous exercise, navigate down to the sec-
ond clip. 

This clip has a similar problem as the one you fixed in the previous exercise—the 
shot is uninteresting (and has some wild camera work) at the top, plus you don’t see 
very much of the subject. The clip would probably work better if you slipped the clip 
so that the action happened a bit differently. 

2.	 In the Tools panel select the Slip tool or press Y (Figure 9.11). 

3.	 With the Slip tool active, place it over the second clip and click and drag to the left. 

In the Program Monitor you now have a four up view similar to what you worked 
with in the previous exercise.

4.	 Slip the clip about -8:12 so that the new In point is right before the subject comes in 
frame. Release the mouse to make the edit. 

Figure 9.10  The four up view 
displayed when slipping a clip is 
a great way to visualize the edit. 
Note that this screen shot is from 
the second shot in the sequence. 
The first clip, because there is 
no prior clip, will show black 
in the previous clip part of the 
four up view. 

Linked Audio Slips Too!
When you slip a clip with 

linked audio, that linked audio 
will slip as well. Keep in mind that 
if you’ve unlinked a clip and slip 
either the video or audio, you can 
potentially unsync a clip.

Figure 9.11  You can find the 
Slip tool in the Tools panel, or 
press the keyboard shortcut Y 
to activate it.
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Slipping Using Keyboard Shortcuts
Now that you have the hang of slipping in Adobe Premiere Pro, you can go to the next level. 
Using keyboard shortcuts can make you a faster editor. In fact, you can slip a clip directly 
from the keyboard. To perform a slip edit on a sequence, use the following technique. 

1. 	 With the project file from the previous exercise still open, navigate to the third clip in 
the sequence. 

This is a nice shot, but unlike the two clips you fixed earlier, this clip could benefit 
from having a bit more of a camera pan. So you’ll slip it by using keyboard shortcuts.

2. 	 Press Option+Command+left/right arrow (Alt+Ctrl+left/right arrow) to slip the clip back-
ward or forward by a single frame at a time. If you want to slip five frames at a time, just 
add the Shift key to the shortcut. For this clip, we slipped it forward (right arrow) 2:15.

Additional clips are provided in this sequence so you can practice slipping using any of 
the methods from the previous sections.

Sliding Edits
A specialty type of trim operation is the slide edit. Although you’ll certainly use the Slide 
Edit tool from time to time, most likely you’ll use ripple and roll or even a basic trim more 
often. With that said, let’s look at an example of when a slide edit is perfect. 

Let’s say you have three shots of a basketball dunk contest. The first shot shows a 
player dribbling the ball and approaching the basket, the middle shot shows the actual 
dunk, and the third shot shows the player celebrating and the crowd going crazy. The 
sequence of shots is working OK, but the timing feels off. You’d like to see more cel-
ebration after the shot and less of the lead in to the actual dunk. The middle shot of the 
actual dunk is perfect as is. 

You could use other trim tools to make this happen, but you can make this trim all in one 
step using the Slide tool. The Slide tool works by leaving the duration of the clip you’re 
sliding the same while adjusting the Out point of the clip to the left and the In point of 
the clip to the right. When you slide, it’s also important to remember that the duration of 
your sequence doesn’t change. 

Using the Slide Tool
Let’s perform a simple slide edit. The use of this tool makes it easy to work because the 
sequence will update as you drag.

1.	 Navigate to the Chapter Files > Chapter_09_Media > [Version Number] and open 
the project Ch09_slide.prproj.

2.	 Play back the sequence.

Although the sequence is working OK, you can make it a bit better by using a slide 
edit. The middle clip is working, but the first clip seems a little short and the third 
clip seems a little long. 

3.	 In the Tools panel select the Slide tool or press U (Figure 9.12).

Slip in Larger Chunks
If pressing the keyboard 

shortcut a thousand times to make 
a slip doesn’t sound appealing to 
you, you can adjust how big your 
Large Trim Offset is by opening 
Preferences and then choosing 
the Trim category. The Large Trim 
Offset parameter is at the top. 

Slipping More Confidently
As you slip with the keyboard 

shortcuts, neither the Program 
Monitor nor Source Monitor will 
display a multiple view display. 
Therefore, you might find it difficult 
to slip in this fashion. However, you 
can always open the clip into the 
Source Monitor by double-clicking. 
Then, as you use the keyboard 
shortcuts, you should see the In 
and Out points of the clip moving 
in tandem. Opening a clip into the 
Source Monitor also has the added 
benefit of allowing you to see the 
handles you have on a clip.

Figure 9.12  You can find the 
Slide tool in the Tools panel, 
or press U to activate it. 
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4.	 Place the Slide tool over the middle clip, and then click and drag to the right. 

As you drag, you’ll notice below the clip that there is a timecode sticky showing you 
how far you’re sliding the middle clip. Additionally, the Program Monitor changes 
to a four up display. The clip you’re sliding is on top (its In and Out points shown), 
below on the left (with source timecode overlays) is the Out point of the first clip, 
and on the right you see the In point of the third clip (Figure 9.13). 

 

5.	 Slide the middle clip by +2:00 to the right to make the first clip longer and the third 
clip a little shorter. This should help the sequence flow a bit better. 

6.	 Play back the sequence to see the results. 

Sliding Using Keyboard Shortcuts
Like slipping edits, you can improve your speed by sliding using keyboard shortcuts. The 
same issues of visualizing a slide hold true, but by looping playback (by pressing the Loop 
button in the Program Monitor) you can quickly judge the effectiveness of the slide.

1. 	 With the previous exercise file open, choose File > Revert. 

2.	 Select the second clip with the Selection tool to slide it again.

This time you’ll use keyboard shortcuts to do it quickly.

3. 	 Press Option+left/right arrow (Alt+left/right arrow) to slide the clip backward or for-
ward by a single frame at a time. If you want to slide five frames at a time, just add 
the Shift key to the shortcut.

Keep in mind that neither the Program Monitor nor the Source Monitor will display a 
multiple view like the one you saw when you used the Slide tool. However, you’ll be 
able to see the two edit points on either side of the clip you’re sliding move. 

Figure 9.13  When you slide a 
clip, the Program Monitor will 
show a four up display, making it 
easy to see where in the preced-
ing and following clips new edit 
points will be positioned. 

Adjust the Large Trim Offset
You can adjust your Large 

Trim Offset parameter to slide more 
then five frames at a time. Just 
choose the Trim category in the 
Preferences dialog.
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Using the Trim Monitor
The Selection, Ripple Edit, Slip, and Slide tools are very useful and can make quick work 
of trimming clips, but sometimes you’ll need to make more than one type of trim to make 
an edit work. At times that may mean rippling one side of an edit and then rolling the edit 
point; other times it may mean rolling an edit and then fine-tuning dialogue with a ripple. 

Regardless of what you need to do, many editors have come to rely on a “super” tool 
that lets you perform various trims in one spot rather then having to switch between 
various tools. In Adobe Premiere Pro, this tool is called the Trim Monitor (Figure 9.14). 

 

Before you actually start using the Trim Monitor, let’s first call it up. 

1.	 Place the current-time indicator on or near an edit point.

2.	 Choose Sequence > Trim Edit or press T.

Keep in mind that if the current-time indicator is placed in the middle of a clip and you 
choose Sequence > Trim Edit or press T, the current-time indicator will snap to the near-
est edit and the Trim Monitor will then open. 

Figure 9.14  The Trim Monitor 
looks confusing, but it’s actually 
a straightforward tool that allows 
you to quickly make ripple and 
roll edits as well as preview edit 
point changes you’ve made. 
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Overview of the Trim Monitor
When you first open the Trim Monitor, you might be a little confused at what you’re look-
ing at, so we’ll break it down for you here. 

Clip information 
It’s pretty obvious that the clip on the left side is the outgoing clip, and the clip on the 
right is the incoming clip. Below each clip is a mini timeline where you can see the cur-
rent In and Out points, its duration, and the source timecode of either the Out point (left) 
or In point (right) of the clip. Underneath the mini timeline for each side is the Out/In 
Shift timecode display, which will update as you make an edit. 

Track selection and edit point timecode
In the middle portion of the Trim Monitor, you can choose what you want to display in 
the Trim Monitor by using the Track menu (Figure 9.15). Any video tracks or audio tracks 
that you have on a sequence can be selected here. Below this menu, you can see the 
sequence timecode of where the edit happens on the sequence. 

Trimming and playback controls
In the middle of the Trim Monitor at the bottom you’ll find several navigation and trim-
ming controls (Figure 9.16). Also included is the ability to preview and loop the edit point. 
Depending on the type of edit you’re doing, you can click the +/- 1 or +/- 5 buttons to 
ripple or roll one or five frames forward or backward. If you want to use a custom value, 
you can enter that value in frames in the middle input box. 

You can also use the Previous and Next Edit point buttons to load other edits into the 
Trim Monitor. In addition, you can load adjacent waveforms by clicking the Load Adja-
cent Waveform button (Figure 9.17). This feature is a huge help when you’re struggling 
to figure out where an audio hit is between two clips or stitching together dialogue. To 
utilize the Load Adjacent Waveform button, you must first choose an audio track in the 
Track Selection menu. By default (with the button off), Adobe Premiere Pro will show 
the audio waveforms with their handles. With the button on, you won’t see any handles 
in the audio but rather just where the In and Out point of the audio meets at the edit 
point. We’ll discuss the use of the Load Adjacent Audio Waveform button in movies 
about the Trim Monitor for this chapter (on the disc). 

Using the jog wheels, you can jog either the Out point (left) or In point (right), allowing 
you to essentially ripple the edit. By using the middle jog wheel, you can roll the edit. 
When you press the spacebar, the Trim Monitor will preview the edit using the Preroll 
and Postroll amounts, which you can configure in the General section of the Prefer-
ences dialog. 

Figure 9.15  The menu in the 
middle of the Trim Monitor lets 
you choose what tracks at the 
existing current-time indicator 
position you want to trim. 

Figure 9.16  The trim buttons 
and jog wheels in the middle of 
the Trim Monitor allow you to trim 
numerically or drag (using the jog 
wheels) trim an edit point. 

Controlling Multiple 
Frame Trim

In the Trim Monitor the Multiple 
Frame Trim buttons default to +/- 5 
frames. If you choose Premiere 
Pro > Preferences > Trim on the 
Mac or Edit > Preferences > Trim on 
Windows, you can enter a custom 
value for these buttons. 
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Outgoing 
clip handle

Incoming 
clip handle

Edit point Edit pointLoad Adjacent 
Waveform button 

(disabled)

Load Adjacent 
Waveform button 

(enabled)

Clip selection 
Above and below each clip is a thin bar. When both sides are blue (active), trims that 
you do will affect both sides, essentially performing a roll edit. By clicking on one side 
or the other, only that side becomes active, and the bars for the other side turn gray, 
which allows you to perform a ripple edit on the selected side. To get back to a roll edit, 
simply click the thin gray divider between the two clips (Figure 9.18). If you’re more of a 
keyboard person, another way to select focus in the Trim Monitor between either side 
of the edit or both sides is by using these shortcuts: Option+1 (Alt+1) for outgoing and 
incoming, Option+2 (Alt+2) for outgoing, and Option+3 (Alt+3) for incoming.

Figure 9.17  The Load Adjacent 
Waveform button is available 
when you have an audio track 
loaded into the Trim Monitor. 
With the button disabled, you’ll 
see waveforms from the loaded 
clips with handles (left). With the 
button enabled, you’ll see wave-
forms without handles (right), 
which makes it much easier to 
hear the exact cut.
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Performing Ripple Edits in the Trim Monitor
Performing ripple edits in the Trim Monitor is a quick way to perform ripple edits. You 
can also see both clips on either side of the edit, allowing you to quickly see the exact 
In and Out points of each clip. 

1.	 Navigate to the Chapter Files > Chapter_09_Media > [Version Number] and open 
the project Ch09_trimedit.prproj. 

This sequence has clips from previous exercises that you rippled and rolled. It’s 
not meant to be a cohesive sequence but rather to show you the mechanics of the 
Trim Monitor. 

2.	 Look at the first edit point. As you did earlier in the chapter when you rippled this 
edit using the Ripple Edit tool, you need to fix this edit point. But this time you’ll use 
the Trim Monitor. 

3.	 Position the current-time indicator over the first edit, and then press T to launch the 
Trim Monitor. 

4.	 When the Trim Monitor opens, click on the clip on the left side of the Trim Monitor. 
Notice that the blue line above and below either side is now only on the left side of 
the first clip. This indicates that you’ll be performing a ripple edit (Figure 9.19).

Figure 9.18  The positioning 
of the blue line over the clips in 
the Trim Monitor determines if 
you’ll be performing a ripple edit 
(when positioned over one side 
or the other) or a roll edit (when 
positioned over both sides). 

Figure 9.19  The blue line over 
the left clip shows that you’ll be 
performing a ripple edit. You can 
ripple this side of the edit in a 
number of different ways. 
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5.	 To perform a ripple edit, you have a few choices:

■■ You can place the cursor over the Out or In point in each clip’s mini timeline below 
the clip. The cursor will change to the Ripple Edit tool. For this exercise, position 
the cursor on the Out point of the first clip and drag forward about three seconds. 

■■ You can position the cursor over the actual image of the clip (either side); the cur-
sor will change to the Ripple Edit tool. You can then drag to perform the ripple. 
To make the edit in this exercise, position the cursor over the clip on the left side 
to ripple the clip’s Out point. For this clip, drag forward about three seconds.

■■ You can use the trim buttons (either the multiframe buttons or single frame but-
tons). In this case you’d use the positive (+) multiframe or single frame buttons. 
You can also use the input box between the trim buttons and type a custom 
value for the trim. For this exercise, type a positive number: about +3:00.

■■ You can place the cursor over the Outgoing Out point or Incoming In point time-
code and click and drag to ripple that point. In this example, use the Outgoing 
Out point timecode, again going forward about three seconds. 

■■ You can use the Jog Out/In point jog wheels to ripple either the Out point (left 
wheel) or In point (right wheel). For this exercise, use the Jog Out point wheel 
(left wheel), jogging forward about three seconds

6.	 Using the method of your choice, ripple the first clip forward so the person being 
interviewed doesn’t get cut off. We rippled forward +00:03;00. That’s the point 
where the subject says “…my death is just the end of the….” Notice after you make 
the change that the edit point in the sequence has also been updated. 

7. 	 In the Trim Monitor press the spacebar to preview the edit. If you’re not satisfied 
with the results, ripple the clip again until the edit feels correct to you. 

Performing Roll Edits in the Trim Monitor
As you saw in the previous exercise, making ripple edits in the Trim Monitor is pretty 
straightforward. In a similar fashion you can also quickly make roll edits in the Trim 
Monitor. Let’s see how this works. 

1.	 With the same project open from the previous exercise, navigate to the third edit 
point in the sequence (between the third and fourth clips).

2.	 Play through this edit a few times. As in the section “Rolling Edits” earlier in this 
chapter, this edit could benefit from a roll edit. The cut to the interviewer happens 
while the person being interviewed is still delivering his thought. Also, there are 
some misspoken words at the top of the angle with the interviewer. 

3.	 Position the current-time indicator over the edit, and then press T to launch the 
Trim Monitor. 

4.	 When the Trim Monitor opens, make sure that the blue line is above and below each 
clip. If the blue line is still on one side (from the previous exercise), click the thin gray 
line between the two clips. With the blue line above and below both sides, you’ll 
know you’re performing a roll edit (Figure 9.20). 

26 Ripple and Roll 
Options in the Trim 
Monitor

Check out this video to learn more 
about using the various options 
to ripple and Roll clips in the Trim 
Monitor. 
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You want to roll this edit further in time so that the person being interviewed 
can finish his thought, and there aren’t any misspoken words at the start of the 
incoming clip.

5. 	 To perform a roll, you have a few choices:

■■ You can position the cursor between the actual images of the clips; the cursor 
will become the Rolling Edit tool. You can then drag to perform the roll. In this 
exercise you click and drag to the right about one second. 

■■ You can use the trim buttons (either the multiframe buttons or single frame but-
tons). In this case you’d use the positive (+) multiframe or single frame buttons. 
You can also use the input box between the trim buttons and type a custom 
value for the trim. For this exercise, type a positive number—a value of about 
one second. 

■■ You can place the cursor over the Edit Point Position timecode (the middle time-
code value) and click and drag to roll the edit point. In this example you’d drag to 
the right about one second. 

■■ You can use the Jog Roll In and Out points jog wheel (the center wheel) to roll 
the edit. For this exercise, jog to the right about one second.

6.	 Using the method of your choice, roll the edit so that the edit happens right before 
you hear the interviewer say, “Some people.” This is one second forward of where 
the edit is currently. Notice that after you make the change, the edit point in the 
sequence has also been updated.

7. 	 In the Trim Monitor press the spacebar to preview the edit. If you’re not satisfied 
with the results, roll the edit again until the edit feels correct to you. 

Making Split Edits
So far all of the trims you’ve made have been symmetrical, meaning that if a clip had 
linked audio and you rolled it forward ten frames, the audio would also roll forward ten 
frames. However, as any experienced editor knows, this type of edit often seems a little 
jarring. For example, in a dramatic scene between two actors, you may want to continue 
to hear one actor from one take but cut to the other actor before hearing that actor’s 
audio clip. This type of edit is known as a split edit or L-cut. 

Figure 9.20  With the blue line 
over both clips, you’ll be perform-
ing a roll edit. There are a number 
of different ways to perform the 
roll edit. 

27  
Trimming to Beats 
and Words

Check out this video to learn how 
to use markers to mark beats and 
words, and how to align edits to 
those markers. We also show you 
how to use speech analysis to find 
dialogue quickly so you can trim to 
specific words and phrases.

Split Edits in the 
Source Monitor

If you have a good idea for creating 
a split edit before editing a clip into 
a sequence, you can also create 
split edits in the Source Monitor by 
right-clicking on the mini timeline 
and choosing Mark Split. Then 
select whether you want to mark 
video/audio in or out.
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The quickest and easiest way to create a split edit is in a sequence. Normally, if you use 
trim tools, such as the Ripple Edit or Rolling Edit tools on a linked clip, both the video 
and the audio will be trimmed together. Although this default behavior is often useful, 
you’ll sometimes want to create a split edit; doing so is easy. 

1. 	 Select either the Ripple Edit or Rolling Edit tools. 

2. 	 Place the trim tool over the edit you’re trying to manipulate. 

3.	 Before clicking and dragging, hold down the Option (Alt) key, and then click and drag. 

By holding down the Option (Alt) key while trimming, you’ll temporarily unlink audio 
from video, allowing you to quickly create a split edit or L-cut between adjacent 
clips (Figure 9.21). 

4. 	 After making a split edit on a sequence, simply deselect any clips. This way further 
trims will affect both audio and video. 

Maintaining Sync
If you’re anything like us, you might be a little obsessed about sync. Nothing is more 
embarrassing than watching a project with a client and realizing that footage on a 
sequence is out of sync. However, there are times when you might purposely need to 
make footage out of sync for stylistic reasons (such as lifting room tone from a clip) or to 
fix issues often associated with productions that use dual-system recording. 

In this section we’ll discuss ways to maintain sync.

Linking and Unlinking Audio and Video
When you ingest a clip that has video and audio, Adobe Premiere Pro automatically 
links the audio and video. Generally, this is a good thing, but sometimes you’ll want 
to unlink video from audio. Also, there are times when you’ll want to link two clips that 
weren’t ingested together. Let’s look at how this works in Adobe Premiere Pro: 

■■ Unlinking clips. To unlink video from audio, select the clip and either choose Clip > 
Unlink or right-click on the clip and choose Unlink. 

■■ Linking clips. To link clips, reverse the procedure for unlinking clips. That is, choose 
Clip > Link or right-click on the clip and choose Link. 

■■ Linking disparate clips. If you want to link clips that weren’t ingested together, you 
can. For example, if you spent time lining up a sound effect with a clip, you can then 
link them so when or if you move the new pair around the sequence the clips will stay 
together. To do this, select the first clip and then Shift-click the other clip(s) you want 
to link. Then choose Clip > Link or right-click on one of the clips and choose Link. 

Making Splits Using 
Locked Tracks

Another method you can use to 
make a split edit is to lock either 
video or audio tracks. When 
tracks are locked, you can trim an 
unlocked track and create a split 
edit. Just be aware that depending 
on the type of trim that you perform, 
you might push audio and video out 
of sync with each other.

Figure 9.21  By temporarily 
unlinking audio from video in a 
linked clip, you can use Adobe 
Premiere Pro’s various trim tools 
like Ripple Edit and Rolling Edit to 
create split edits. 

Merge Clips
A great new feature in Adobe 

Premiere Pro CS 5.5 is the Merge 
Clips command. The command, 
which is great for dual-system 
projects (recording sound and 
video separately), allows you to 
merge audio and video together 
that weren’t captured or imported 
together. You can merge them by 
using In and Out points, timecode, 
and even clip markers. After you 
choose your preferred method, you 
can create a new clip (and name 
the new clip) so that in the rest of 
the project the once disparate clips 
will be together. We’ll cover this 
feature more in Appendix B, “DSLR 
Workflow Guide.” 
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■■ Unlinking disparate clips. To unlink multiple clips, reverse the procedure for linking 
them together. Either choose Clip > Unlink or right-click on part of the linked clip 
and choose Unlink. 

Moving and Slipping Clips into Sync
If part of a clip (either audio or video) has gone out of sync, one option you have to 
make the clip in sync again is to move the offending out-of-sync portion back in sync.

When a clip goes out of sync, a sync flag appears on the upper-left corner of the clip. If 
you right-click on this flag, you’ll be presented with two options—Move into Sync and 
Slip into Sync—to get the clip back into sync (Figure 9.22). 

 

Move clips into sync
If you choose the option Move into Sync, Adobe Premiere Pro moves the out-of-sync 
portion back into sync with the other part of the clip. This means that clips are physically 
repositioned in the Timeline.

Slip clips into sync
If you choose the option Slip into Sync, Adobe Premiere Pro slips the out-of-sync por-
tion back into sync. Slipping the clip won’t move the out-of-sync portion. It will remain 
on the same part of the sequence as it was when it was out of sync. Instead, Adobe Pre-
miere Pro will slip the part of the clip you selected to slip (as long as there is adequate 
media) back into sync. 

Next Steps
Now that you’ve refined an edit, the next step is to finish an edit. In the following chap-
ters we’ll discuss color correction and grading, audio mixing and repair, quality control, 
and finally publishing. 

Figure 9.22  When a clip is 
out of sync with linked audio or 
video, a flag appears on the clip 
indicating how far the clip is out 
sync. Right-clicking on the flag 
will bring up the two options to 
get the clip back into sync. 

Alternate L-cut
Purposely moving video or 

audio clips out of sync and then slip-
ping them back into sync is one way 
(although not recommended) to cre-
ate a split edit or L-cut in a sequence.

Out of Sync? Work 
with Video

If you notice on a sequence that 
footage is out of sync, even though 
Adobe Premiere Pro is telling you 
that footage is in sync, a good strat-
egy is to get your audio edits cor-
rect and then slip or otherwise trim 
video to match. If you start moving 
or slipping out-of-sync audio and 
video, you can quickly go crazy!




